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1	 INTRODUCTION

3D Sprint® is 3D Systems’ exclusive software for preparing and optimizing CAD & polygon data and managing the additive 
manufacturing process on its plastic 3D printers. Shipping with each supported 3D Systems printer, 3D Sprint delivers tools that 
allow you to 3D print better parts.  
 

3D Sprint enables you to:

Setting the New Standard in 3D Printing
Experience true productivity with exclusive additive manufacturing software for 3D Systems Plastic Printers.

Introducing 
3D Sprint 
Version 5.1

Increase Productivity for 3D Systems Plastic Printer

Prepare and optimize CAD data and then manage the additive 
manufacturing process on your 3D Systems’ plastic 3D 
printers.

Go from CAD to Print

3D Sprint delivers all the tools you need to go from design to 
3D print, offering an unparalleled user experience across 3D 
Systems plastic printers.

Print Better Parts

Eliminate geometry processing artifacts with smarter 
geometry processing and powerful slicing technology.

Streamline Time to Finished Parts

Save on material and post-processing time without 
compromising on part quality.

Increase Productivity with Optimized Data Management 

Estimate print time and optimize material levels and usage 
both before and during the print operation.

3D Sprint 5.1 includes key new features and enhancements that bring new value to these objectives with a special focus on 
capabilities that are required to move from rapid prototyping to serial production.
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2	 INSTALLATION

System Requirements
For the latest system requirements information and to learn about specific qualified system configurations, go to the System 
Requirements page. Some users have had success running system configurations that deviate from the supported listed on our 
website. In such cases, these configurations are not officially supported by 3D Systems, Inc.

Additionally, we test a variety of hardware platforms in combination with the graphics subsystems. While we make every attempt 
to be as thorough as possible, hardware manufacturers change their products frequently and may be shipping newer products 
or have discontinued active support for others. Check the support section of the website for the latest system requirement 
information and specific qualified systems. 

NOTE:	It	is	recommended	to	use	the	Microsoft	Windows	10	Operating	System.	As	of	3D	Sprint	4.0	and	newer	versions,	
Windows	7	and	Windows	8.0	are	no	longer	supported.	If	you	are	on	Windows	7,	please	refrain	from	upgrading	to	3D	Sprint	
4.0	or	newer.	For	those	using	Windows	8.0,	please	update	to	Windows	8.1	to	ensure	compatibility	with	3D	Sprint	4.0	or	
newer.

Download and Install Software
You can download and install 3D Sprint from the getting started page.

In addition, automatic software updates are available if you set the Check for updates on launch option to True in Preferences 
and a valid activation code is activated, and your computer is connected to the Internet. 3D Sprint will check if a newer version is 
available and will download it automatically for installation.

You can also visit support.3dsystems.com, select your printer, then download 3D Sprint for the Software Downloads section on you 
printer’s site.

Activate License
3D Sprint requires license activation to run the application on your PC. You can activate a permanent license by using an activation 
code. 

After you start 3D Sprint, the License Manager window opens. The License Manager allows you to activate and use the 3D Sprint 
software. For more information, read the CimLM Licensing Guide. 

If you have a 3D Systems printer, but do not 
have the activation code for 3D Sprint, please 
request it from the 3D Sprint registration 
page here:

https://support.3dsystems.com/s/get-3d-
sprint *

*This request will go into a system, and we 
will produce activation codes within 24 hours 
(excluding weekends).

If you are an existing user and have already activated the license on your PC with the previous version of 3D Sprint, all the existing 
activation codes will be retained in the new license system, so you can run the newer version of 3D Sprint without re-activating the 
license.

https://s3.amazonaws.com/dl.3dsystems.com/binaries/support/downloads/ApplicationInstallers/3D+Sprint/v4/3D+Sprint+4.3+-+System+Requirements+Guide.pdf
https://s3.amazonaws.com/dl.3dsystems.com/binaries/support/downloads/ApplicationInstallers/3D+Sprint/v4/3D+Sprint+4.3+-+System+Requirements+Guide.pdf
https://support.3dsystems.com/s/article/3D-Sprint
http://support.3dsystems.com
https://softwaresupport.oqton.com/s/article/CimLM-Licensing-Support
https://support.3dsystems.com/s/get-3d-sprint
https://support.3dsystems.com/s/get-3d-sprint
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3	 NEW	PRINTERS,	FEATURES	AND	IMPROVEMENTS

Please note that printers must be running the required printer firmware version to be able to submit print jobs with 3D 
Sprint 5.1. For the latest firmware version please consult the 3D Sprint - Minimum Firmware Guide.

Requirement Notice

Common

Subscription & Add-on Licensing
3D	Sprint has introduced a new Subscription and Add-on licensing model, allowing customers to purchase licenses for multiple 
years based on their maintenance date. With the basic or subscription license, you can add specific licensed features as required. 
This new model provides a more affordable option for you to work with 3D	Sprint.

Note:	Please	be	aware	that	periodic	reminders	will	prompt	customers	to	renew	their	subscription	to	ensure	uninterrupted	
access	to	the	application.

Home Tab
Introducing the new Home tab. Upon launching the application, you now have access to the Home tab, designed to be your 
resource hub.

The Home page offers a clean and intuitive space to meet your printing requirements. It also features convenient web links that 
allow you to: 

Note:	Features	labeled	with	 	require	a	3D	Sprint	Subscription	for	access.	With	the	Basic	or	Subscription	
model,	you	can	add	specific	licensed	features	labeled	with	 	as	required.	

For	assistance,	please	reach	out	to	our	technical	support	team	at	http://www.3dsystems.com/support	or	contact	your	
regional	sales	manager.

 y Access recently used files

 y Perform basic tasks for your printing 
job, such as:
 � Creating new documents
 � Opening files
 � Importing data
 � Managing licenses
 � Accessing Preferences

 y Navigate through Help resources

 y Access printer and material details

 y Find customer guides

 y Consult the Knowledge Base

 y Connect with technical support

 y Explore shopping details

All these links can be easily found within the Home tab interface.

Key Improvements

https://s3.amazonaws.com/dl.3dsystems.com/binaries/support/downloads/ApplicationInstallers/3D+Sprint/v4/3D+Sprint+4.3+-+Minimum+Firmware+Guide.pdf
http://www.3dsystems.com/support
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User Defined Priority in Auto Place 
The priority of parts for auto-placing can now be manually reordered through a user-friendly interface within the Auto	Place 
command. Furthermore, any changes made to the order of parts can be synchronized with the Parts	List.

View Overlay Enhancements
The View	Overlay now includes new tools that enhance object visibility and provide quick measurements.

 y Smooth	Shading	Tool
This tool improves object visualization by displaying objects with smooth shading, reducing the visibility of unnecessary 
tessellation. The result is a more realistic representation of objects within the application.

Basic View (A) vs. Basic View with Smooth Shading (B)
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 y Quick	Measure	Tools	
The new Quick Measure tools provide dynamic and rapid measurements for various applications:

 y Coordinate : Checking X, Y, and Z coordinates of a specific point of interest.

 y Down	Face	Angle : Measuring precise down face angle with reference to the 
Printer Platform.

 y Distance: Measuring linear distances between features while using various 
commands. For example, measuring distances between anchor points or support 
beams in Smart Supports to determine printability. Also, measuring distances on 
the part to decide if supports are needed when using the Smart Support command.

 y Thickness : Measuring the thickness of a feature.



3D Sprint 5.16

 y Gap	Clearance : Measuring the gap distance between two opposing faces.

Egg Shell Improvements 
The Egg	Shell	Mold	command has been improved to offer a selection of pre-defined sprues and accessories, making it easier to 
create an egg shell mold. You can now import these preset sprues and accessories directly into the Printer Platform by using the 
Import button in the command. Alternatively, you can access them via a convenient “Sprues	and	Accessories” link within the 
dialog.

	

Note:	This	command	is	available	with	a	‘Eggshell’	Add-On.

File Import
Native CAD File Import has been updated to support the following versions.

CAD	Application File	Extension Supported	Versions
STEP .stp, .step AP203, AP214, AP242
IGES .iges .igs Up to 5.3
Parasolid .x_t .x_b 9.0 - 35.0.149
ACIS Text / Binary .sat .sab R1 - 2023.1.0
CATIA V4 .model 4.1.9 - 4.2.4
CATIA V5 Part / Assembly .catpart, .catproduct V5 R8 - V5-6 R2023

Creo (Pro/E) Part / Assembly .prt, .asm Pro/E 16 - Creo 9.0

Siemens NX .prt, .asm 11 - NX 2212
SOLIDWORKS Part / Assembly .sldpt, sldasm 98-2023

VDA-FS .vda 1.0 - 2.0
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Miscellaneous Enhancements

 y View	Overlay	Consolidation - The View	Overlay has been streamlined by implementing a fly-out style combo for mutually 
exclusive options, ensuring a more organized interface with the addition of new tools and options.

 y Random	Priority	in	Auto	Place - When the Priority type is set to “Random,” the Apply button can be repeatedly used to 
obtain different results. Each time it’s clicked, a new priority sequence will be applied.

 y Improved	Object	Visibility	during	Auto-Placement - Objects to be placed can now be temporarily hidden until they are 
ready to be placed. When the update process begins, all movable objects will be hidden and then made visible when they 
are being placed.

 y Volume	Information	for	SLC	Files - Volume details for SLC files are now included in the Property pane, providing easy 
access for reference. Additionally, this information is available in the generated report.

 y Mesh	Random	Color - Addressed the inconsistency in mesh random coloring during part copying, preventing unexpected 
color assignments. Additionally, the range of random colors has been expanded from 32 to 40 for better variety. New 
random colors are now managed as document properties, enhancing color control.

 y Enhancements	 to	Copy/Pattern - Copy numbering now increases per part, ensuring consistent naming. For example, 
when copying objects A and B, the resulting names are A_Copy_1, B_Copy_1, A_Copy_2, B_Copy_2, and so on.

 y Progress	Control	- The progress bar has been enhanced to display informative behavior and status text.

 y Mouse	Wheel	Support	for	Option	Values	- Improved to adjust increments of option values with mouse wheels. Most values 
now increment by 0.1mm, although some options increase by 1mm or 1 degree, depending on their specific meaning.

 y Display	of	Printer	Mode	in	Printer	Queue	- The Printer Mode name is now centered within the Printer Queue column to 
ensure it remains within the column separator bars.

 y Empty	Pending	Queue	- If there are no pending jobs in the queue, a message stating “No Pending Queue” is now displayed 
to provide a more intuitive user experience.
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 y Enhancements	to	Paint 
 � Toggle	Buttons	-	Toggle buttons now sport a smaller format, matching the other command’s style for consistent 

visuals.

 � Local	Undo	and	Redo	-	Local Undo and Redo features are now available, providing you with enhanced control over 
your workflow.

 � Global	Texture	Smoothing	Parameters - You can now conveniently adjust global texture smoothing parameters 
directly in the iniml file, ensuring smoother textures throughout the application.

 � Brush	Gradient	- Introducing the new Gradient option for the Brush tool, enhancing your painting process with the 
ability to smoothly blend colors for seamless transitions.
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Bug Fixes

The following is a list of issues that have been resolved since the last version of 3D Sprint:

 y GW-34322,	
GW-34179: Split connectors update issue that occurred when switching between Grid and Boundary.

 y GW-34320: The application would crash when copying a part after undoing a group.

 y GW-34295: The application would crash when using the Duplicate tool on a part in a sub-group.

 y GW-34248: The Split tool caused the application to crash in some models.

 y GW-33997: The "S" keyboard shortcut key did not work to select multiple stilts.

 y GW-33883: The application would crash when switching to eggshell from the Paint dialog.

 y GW-33802: The application would crash when using the Adjust Color command.

 y GW-33775: The application would crash during the execution of the Hollow command with minimal values on a specific 
file.

 y GW-33762: Various issues related to the model manager affected functionality.

 y GW-33750: Texture glitches were appeared after boolean operations or mesh hollowing.

 y GW-33724: Progress bar remained at 100% upon entering the Adjust Color dialog.

 y GW-33666: The application would crash while applying texture softening using custom values.

 y GW-33160: The Update Firmware window was not centered when clicking on "Check for Updates."

 y GW-33151: The application locked up the computer when attempting to import an NX files (.prt).

 y GW-33150: Error messages appeared when importing SOLIDWORKS files (.sldprt).

 y GW-33120: 3D Sprint UI elements were left behind when switching to a different display with the Shift + Windows + 
Arrow keys.

 y GW-32715: Parts would disappear when using the “Multi Platform” option in the Auto Place command.

 y GW-32583: Explanation about CAD import options was missing in the Help documentation.

 y GW-32536: The application would crash in cases of auto placement involving all possible rotations.

 y GW-32518: Parts disappeared after applying noise.

 y GW-32355: Inability to import STEP files with Korean file names.

 y GW-30149: An incorrect "<Part Name> is too far from origin. Move it to the origin?" warning was shown after importing 
the part even if the part was already on the Printer Platform by the auto-place process on import.

 y GW-28839: The application would crash when the Fix command was used multiple times.

 y GW-27085: Creating a hole resulted in a bad part.

 y GW-22326: No warning was observed when jumping from the Split command to another command with unsaved 
changes.

 y GW-20113: DXF files were not imported correctly in the Engrave tool.

 y GW-8123: The button for the PART NORMAL FIX tool remained enabled even after the completion of the part normal 
fix.
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SLA
Note:	Features	labeled	with	 	require	a	3D	Sprint	Subscription	for	access.	With	the	Basic	or	Subscription	
model,	you	can	add	specific	licensed	features	labeled	with	 	as	required.	

For	assistance,	please	reach	out	to	our	technical	support	team	at	http://www.3dsystems.com/support	or	contact	your	
regional	sales	manager.

New SLA 750 Dual Printer Support

3D Sprint 5.1 now supports the new SLA	750	Dual	Printer.

The SLA 750 Dual printer is the world’s first synchronous dual-laser SLA printer 
delivering up to twice the speed and triple the throughput of current SLA 
printers, using dual imaging systems together with a proprietary scan algorithm, 
Hyper-Scan™	vector technology, developed especially for efficient, high-quality 
production manufacturing. 

The following is available in 3D Sprint to 
support SLA 750 Dual printer higher 
throughput printing:

 y All the common SLA toolset

 y The Remote Print function in the Queue 
tab

 y Slicing infrastructure and enhancements

Key New Features

http://www.3dsystems.com/support
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Key Improvements

Smart Support Improvements
The following improvements have been implemented in Smart	Support to optimize support structure controls and enhance 
productivity.

 y Base	Thickness	of	Empire’s	Volume	Support - Introducing a new control for the base thickness of Empire’s volume support. 
Actual base thickness will now be determined by the maximum values of both support thickness and base thickness. This 
option is particularly useful when working with high-temperature	AMX materials.

 y Enhanced	Anchor	Point	Generation	and	Filtering - Introducing an enhanced method for filtering anchor points. This 
filtering process has been seamlessly integrated as a post-processing step in anchor point generation, designed exclusively 
for SLA printing. Importantly, this enhancement leaves edited anchor points unaffected, preserving your customized 
adjustments.

Pre-Implementation of Enhanced Anchor Point Generation and Filtering Post-Implementation of Enhanced Anchor Point Generation and Filtering

 y New	 Strong	 Support	 View	 Option - Enhanced 
visibility by introducing the “Strong	Support” view 
option, which uniquely colors and highlights strong 
supports, making them effortlessly distinguishable.
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 y Enhanced	 Tip	 Thickness	 Control	 for	 Empire’s	 Strong	 Support - Introducing an advanced setting that allows precise 
adjustment of the tip thickness, working alongside thickness,  spread level, and spacing parameters to refine the strong 
support’s structure.

 y Automatic	Strong	Anchors	 for	Low	Regions - Strong	Anchors can now be applied automatically to local low regions 
around point and line anchors. To revert this feature, simply utilize the existing unassigned workflow.

 y Anchor	Point	Projection	on	Polyline	  - Improved anchor point placement accuracy on polylines by adding 
interpolation points during anchor polyline drawing. This optimization assists in projecting onto the part, leading to more 
precise anchor placement.

Before After
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 y Flexible	Strong	Anchor	Intervals - Introducing enhanced control with strong anchor intervals. In the Modify tab, a new 
“Strong” option allows you to fine-tune Strong Anchor intervals. When manually editing anchors using tools like Box, Lasso, 
Edge, or Polygon, this feature enables you to position strong anchor points flexibly between point or line anchors.

Box Strong Anchor Intervals Lasso Strong Anchor Intervals

Edge Strong Anchor Intervals Polygon Strong Anchor Intervals

 y Anchor	Point	Reprioritization - Elevated the priority of primary region, line and point region anchors over sharp edge 
points so that lowest layers could be supported with a 0 offset. Additionally, there have been improvements made to sharp 
edge processing.
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 y Enhanced	Anchor	 Point	 Corner	Alignment - Enhanced corner alignment for anchor points, ensuring their consistent 
placement over edges.

Before After

 y Exclude	Gap	Clearance - Expanding coverage to concave areas through 3D analysis, the Exclude	Gap	Clearance now 
removes primary points found on the tops of arches within negative features.

Before After

Additionally, the max range value for the Exclude	Gap	Clearance parameter has been increased from 10 mm to 20 mm, 
resulting in broader coverage.

 y Expand	Base	to	Part - Introducing the new “Expand	Base	To	Part” option, enabling you to expand the base for better part 
coverage and preventing sidewall quality reduction when the top connection meets the part at an angle.

Basic Base Expanded Base
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 y Anchor	Point	Type	Toggling - Toggles have been added to the following options, allowing users to easily enable or disable 
the creation of anchor points for Thin Wall, Curve Face, and Sharp Edge.
 � Thin Wall
 � Curve Face 
 � Sharp Edge

 y Snap	Anchor	Point	to	Boundary - The “Snap	Anchor	Point	to	Boundary” option is now accessible to users with a 3D	
Sprint	Basic license.

Miscellaneous Enhancements

 y Support	Accura	AMX	Tough	FR	V0	Black - Exposed Accura	AMX	Tough	FR	V0	Black material for the following printers.

Accura AMX Tough FR V0 Black

 � ProJet	6000
 � MDM - 125mm, 50mm, 250mm

 � ProJet	7000
 � MDM - 250mm, 50mm

 � ProX	800
 � MDM - MDM 750SH, MDM 750H, MDM 750F

 � iPro	8000
 � MDM - MDM 750SH, MDM 750H, MDM 750F

 � iPro	9000	SV
 � MDM - MDM 750SH, MDM 750F, MDM 750H

 � SLA	750
 � MDM - Vat Short, Vat Large

 � SLA	750	Dual
 � MDM - Vat Short, Vat Large

 y Support	LLBP	with	QC-D - Both the Additional	Large	Borders and Multiple	Large	Border	Offset options are now accessible 
to provide enhanced support for large	layer	border	prime	(LLBP) with QuickCast	Diamond	(QC-D).

 y Exclusive	Smart	Support	Parameters	in	Sharp	Edge	Category	  - The following Smart Support parameters 
listed below are now accessible exclusively with a 3D	Sprint	Pro or 3D	Sprint	Subscription license.
 � Crease Angle
 � Sharp Edge Cease End Clearance
 � Offset



3D Sprint 5.116

 y Minimum	Value	of	Bottom	Z	Margin	for	Auto	Place	- The minimum value for the “Bottom Z Margin” in Auto Place has 
been aligned with the value specified in the “Minimum Z Height” of the Build Style.

 y Help	 Content	 for	 QuickCast	 Diamond	 Hatch	 and	 Fill	 Options	 - Help descriptions have been added to assist with 
understanding QuickCast	Diamond	Hatch	and	Fill options within the QCD View Slice command.

Bug Fixes

The following is a list of issues that have been resolved since the last version of 3D Sprint:

 y GW-34310: The application became unresponsive with high GPU usage when copying a region in the recoat style dialog.

 y GW-34199: The application would crash when attempting to import a custom Part Build Style.

 y GW-34144: After using the View Slice command, the Save command became unavailable.

 y GW-34097: The drain size changed when moving the mouse to the top surface of a model while running the Vent Drain 
command.

 y GW-34094: Anchor points couldn’t be selected using the Lasso or Box tool when the “Transparent” shading option was 
enabled.

 y GW-33844: A large vent on the up-facing angle had a missing sidewall in the model when using the View Slice 
command.

 y GW-33808: Supports remained on the Printer Platform even after deleting all parts from the parts list.

 y GW-33701: Smart Support was not generated for a specific file (.REG).

 y GW-33664: Tiny redundant support structures were being created.

 y GW-33650: Supports were being generated inside the interior of closed parts.

 y GW-33649: Tip normal orientation was inconsistent.

 y GW-33606: Duplicate style was being imported from the Style Set in the Printer Configuration.

 y GW-33198: Custom build size was causing issues for support and build style generation.

 y GW-33168: The application lacked proper Z control for high step values during sectioning.

 y GW-32965: Anchor points were misclassified.

 y GW-32901: Sharp edge points were created on sidewalls.
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 y GW-32900: Anchor incident occurred outside cross sections on sharp edges.

 y GW-32756,	
GW-32520:

Certain .RCS files were being rejected despite meeting the criteria.

 y GW-32722: Graphics issue with Smart Support visualization.

 y GW-32712: A user interface issue with the Smart Support View section.

 y GW-32647: Gap clearance was removing anchors on non-qualifying down-faces.

 y GW-32646: Supports were hitting sidewalls when gusset was turned off.

 y GW-32387: Unable to access the Update button in Modify under Smart Support.

 y GW-32340: Anchor points were occurring in close pairs.

 y GW-32336: Anchor points were appearing in holes.

 y GW-31104: Custom Layer Thickness values were uneditable in the Edit Build Style Parameters dialog.

 y GW-31027: The Laser hour in the Printer Properties pane showed as 0 for the SLA 750 printer.

 y GW-30356: The QCD build style could be imported into materials that didn't have the interior lattice anchor style 
available.

 y GW-20997: Minor differences were noticed in anchor points and Smart Support structures after regenerating support 
with SLC files.

 y GW-15083: Some anchor points were missing after saving .3dprint file while viewing in the main window.

 y GW-15047: When attempting to save printer log in SLA 750 printer, the Printer Tools > Save Log command was resulting 
in failure.
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Figure 4
Miscellaneous Enhancements

 y Material	Updates - The following materials have been added and updated for 5.0 database.
 � JCAST-GRN	20 - The “JCAST-GRN	20” material is now available for Figure	4	Standalone and Figure	4	Jewelry printers.

JCAST-GRN 20 

Print Mode - 20, 30 Micron

 � Tough	FR	V0	Black - The  “Tough	FR	V0	Black” material is now available for Figure	4	Standalone and Figure	4	
Modular printers.

Tough FR V0 Black 

Print Mode - 20, 30, 50 Micron

 y Thumbnail	 Image	of	Figure	4	Modular	Printer - Updated the thumbnail image of the Figure 4 Modular printer in the 
Printer Configuration dialog.

 y Networking	Troubleshooting	Guide	for	Figure	4	Printers - The networking failure message now provides a hyperlink to 
the Figure 4 Networking Guide when issues arise during printer discovery by IP.
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Bug Fixes

The following is a list of issues that have been resolved since the last version of 3D Sprint:

 y GW-34087: Undoing unrolls of the last applied build style failed to trigger platform resizing as expected.

 y GW-33918: Style name displayed "Standard" for the "For Ceramill" style.

 y GW-33156: Upon connecting to a NextDent 5100 printer with old firmware 1.0.4-9, the main tabs in 3D Sprint became 
inaccessible.

 y GW-32923: After using the View Slice command, the Prepare and Queue tab became inaccessible.

 y GW-32883: The application incorrectly displayed product pictures for Figure 4 Standalone and Jewelry printers.

 y GW-32529: The application would crash when clicking “Next” multiple times rapidly in Figure 4 Scale & Offset workflow.

 y GW-32521: PXL file generation resulted in an error due to a slice layer mismatch in the printer profile.

 y GW-30406: The status of the Figure 4 Modular Control Module did not update to "Disconnected" in the Queue tab, even 
after disconnecting the Ethernet cable from the Control Module.

 y GW-29311: When selecting a part with supports, the Quality Check command displayed "Unknown" for collisions.

 y GW-29310: Collision detection did not function properly for an SLC file in the Quality Check command.

 y GW-29288: SLC files with supports were not auto-placed correctly after using the Linear Pattern tool in the Copy 
command.

 y GW-29116: The "Scale by Unit" command was disabled when a stack existed on the Printer Platform.

 y GW-28814: Renaming the printer was not allowed if it was not connected.

 y GW-20255: The "Show Figure 4 Tips Prompt on Printer Selection" option was accessible in the preferences for a Basic 
license for NextDent.

 y GW-19350: An error message was displayed when sending a job using the "Add Job From File" feature in the French OS.

 y GW-19233: The application did not display different Z-height limits for different materials.
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MJP
Key New Features

New MJP 300W Printer Support

3D Sprint 5.1 now supports the new MJP	300W	Printer.

The MJP 300W is the most advanced and flexible of its wax 
3D printers, capable of addressing a variety of jewelry 
manufacturing workflows with enhanced productivity, 
efficiency, quality, and design freedom.

The following is available in 3D Sprint to 
support MJP 300W printer higher throughput 
printing:

 y All the common MJP toolset

 y VisiJet Wax Jewel Ruby material
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 y Enhanced	Random	Color	View	for	Slice	Data - The Random	Color	View	option has been improved to support Slice data, 
providing enhanced identification capabilities of slice data.

Miscellaneous Enhancements

Key Improvements

Add Part Improvements 
The Add	Part command has been improved to offer a selection of pre-defined tool parts, simplifying the process of adding 
threads to target parts. You can now import these preset threads directly into the Printer Platform using the Import button within 
the command or access them conveniently via the “Sample	Threads” link provided in the dialog.

Additionally, you now have the ability to trim the selected tool part by specifying a desired height value and clicking “Cut.”

Note:	This	command	is	available	with	a	‘MJP	Advanced	Slicing’	Add-On.
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Bug Fixes

The following is a list of issues that have been resolved since the last version of 3D Sprint:

 y GW-34321: The build time for the ProJet 2500W Plus materials was identical in both XHD mode and ZHD mode.

 y GW-34025: The estimate incorrectly displayed the current material amount in the ProJet 2500 Plus printer.

 y GW-33876: The application would crash when selecting an SLC file during mesh fixings, causing instability.

 y GW-33288: Build file creation error after adding HDF mode for ProJet 2500 Plus printer.

 y GW-32973: Display artifact issues with lines appeared on ProJet 2500W/2500IC printers.
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SLS
Key Improvements

Even Section Timeout for Auto Placing
You can now manage even sectioning, which ensures an even distribution of parts across the entire Print Platform when applying 
additional sectional constraints to auto-placed results, by setting the maximum timeout using the Max	Time option. This feature is 
particularly useful for reducing prolonged processing durations.

 

 y User	Defined	Scan	Order - Added more options to the Scan	Order command. You can now easily change the order of 
multiple selections by moving them up or down, dragging and dropping, or sorting them. Any changes you make will also 
update the Parts List.

Miscellaneous Enhancements
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 y Material	and	Configuration	Updates - The following material and build configuration have been added and updated for 
SLS 380 printer.
 � DuraForm	PAx	Black - The new “DuraForm	PAx	Black” material is now available for SLS	380 printer.

DuraForm PAx Black

 � Build	Configuration	Update - All build configurations for SLS	380 printer have been updated to V7.4.

 y Z	Dimension	of	Printer	Platform - The default Z Dimension of the Printer Platform for the following printers has been 
updated to 460mm.

ProX SLS 500 ProX SLS 6100 SLS 380

 y Layer	Area	Estimation - Added an ‘Area’ option to the Layer/Scan Time command for visual inspection of part placement 
configurations to assist with optimization, whether through automatic or manual placement.
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Bug Fixes

The following is a list of issues that have been resolved since the last version of 3D Sprint:

 y GW-34281: In the Part Properties, scaled extents were not visible for parts after importing.

 y GW-34000: The Help icon was missing for the Layer Time command.

 y GW-33985: The Help icon for the Estimate command incorrectly redirected to the Layer Time Help topic.

 y GW-33698: The scroll bar couldn't be found or used when moved to the bottom in the Layer/Scan Time dialog.

 y GW-33502: Inability to apply the NMI patch file to update SLS 6100 configurations in 3D Sprint 3.1 or 4.X.

 y GW-32411: The application crashed after completing step 3 in the Scale&Offset wizard.

 y GW-29790: The application would hang during auto-placement in certain cases.

 y GW-29590: The Label option in the Cage command was not explained in the Help documentation.

 y GW-17056: In both the Build Profile Editor and the Part Profile Editor, the Restore button would become enabled 
without any parameter edits for values in 'mm' and 'mm/sec' units.



  

Find out more at: https://www.3dsystems.com/software/3d-sprint

3D Systems provides comprehensive 3D products and services, including 3D printers, print materials, on-demand parts services and digital design tools. Its ecosystem supports 
advanced applications from the product design shop to the factory floor to the operating room. As the originator of 3D printing and a shaper of future 3D solutions, 3D Systems has 
spent its 30 year history enabling professionals and companies to optimize their designs, transform their workflows, bring innovative products to market and drive new business models. 
Specifications subject to change without notice. 3D Systems, the 3D Systems Logo, 3D Sprint and the 3D Sprint logo are trademarks of 3D Systems, Inc. All other trademarks are the 
property of their respective owners.
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